
APA Style: Citing Sources and Formatting 

Not only does a good research paper include thorough research and thoughtful 
analysis, it follows specific rules for citing sources and formatting. This brief guide will 
illustrate how to correctly reference your sources and set up your paper.   

For science and social studies courses, Connections Education® students should use 
American Psychological Association (APA) style for citing sources and formatting.  

The APA publishes the Publication Manual of the American Psychological Association. 
This is a very useful book, as it goes into great depth explaining the steps for writing 
a paper. The book is available at most bookstores, and your local library likely has 
copies.  

This document covers some essential points discussed in the Publication Manual, such 
as how to correctly reference common sources and format your paper. If you 
encounter an issue, such as citing a source that is not covered in this document, 
consult the Publication Manual or ask your teacher. 

For instance, if you want to incorporate pictures or other images into your paper, ask 
your teacher about the best way to do this. Depending on your teacher’s preference, 
images could be included within the body of the paper or in an appendix. 

Always follow the specific guidelines that your teacher gives you. 
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Formatting Your Paper 
The following are some basic steps for setting up your paper. Note that all formatting 
instructions are designed for use with Microsoft® Word® 2010. 

• Paper Size and Margins – Your paper should be set to 8.5 inches by 11
inches. This is standard letter format. Your page margins should be set at 1
inch on all sides.

o

o

To set margins: Select the Page Layout tab, and then select the Margins
drop-down menu. Set the top, bottom, left, and right margins at 1 inch.

To set paper size: Select the Page Layout tab, and then select the Size
drop-down menu. Set the paper size to Letter. (This should be the
default setting, so this step may not be necessary.)

• Fonts and Font Size – Choose a font and size that is easy to read—Times
New Roman and Courier New are preferred. Use a 12-point font size. The text
color should always be black when writing research papers and formal essays.

o

o

Times New Roman 12 looks like this.

Courier New 12 looks like this.

• Headers and Page Numbers – On the top of each page of your paper, you
should have a “running head” that is flush left. The running head is your
paper’s title that has been shortened to no more than 50 characters (including
spaces). The words Running head should appear before the title on the title
page (but only on the title page). The headline of your paper should be in all
caps. After the title page, use only the shortened version.  Please see the
example provided below.

o To set your header: Select Header from the Header & Footer section of
the Insert tab. Choose the option that aligns your header to the left.
Then type the title of your paper. Close the header and footer view. Your
header will now carry throughout the document as you type. If you need
to edit this information later, choose Header from the Header & Footer
section.

The page number should appear on each page. It should be flush right. 

o To set your page number: Select Page Number from the Header & Footer
section of the Insert tab. Choose Top of Page from the drop-down menu,
and select the option that aligns the page number on the right.

• Punctuation and Spacing – Use only one space after periods and punctuation
marks. Double-space the lines in your paper. This makes it easier to read and
allows your teacher to easily add notes, comments, and feedback. When you
review your drafts, you can also use this extra space to write notes for
revisions and edits. Text should be aligned to the left. Also make sure to indent
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the first line of all paragraphs by one-half inch. You can do this by pressing the 
Tab key. 

o To set spacing to double-spaced: Select the Page Layout tab, and then
select the Paragraph drop-down menu. In the Line Spacing section,
select Double, then select OK.

• Italics and Quotation Marks – Titles of books and plays should be italicized.
Titles of magazines and newspapers should be placed in quotes. There are
many other types of works that should receive this treatment. To review APA
style for different types of works, access the Purdue Online Writing Lab
website.

• Capitalization – When writing the title of any source in the body of your
paper, capitalize all words that are four or more letters long.

o Example: To Kill a Mockingbird

Also capitalize shorter words that are verbs, nouns, pronouns, adjectives, and 
adverbs.  

o Example: There Is Nothing Left to Lose

The Four Parts of an APA Paper 
APA papers contain four parts: the title page, the abstract, the body of the paper, and 
the References page.  

• Title Page – This page should contain the following:

o

o

o

o

The “running head” at the top, flush left (your paper’s title that has been 
shortened to no more than 50 characters, including spaces). Include the 
words Running head before the title, but only do this on the title page. 
The words Running head should be in sentence case, but the title should 
be in all caps. 

The title, which should be in all caps. It should not be more than 12 
words. 

Your name 

The institutional affiliation (this will be your school’s name) 

• Abstract – Your paper should have an abstract. The abstract should be a 150–
250-word summary of the key points of your research. It requires its own
separate page, which comes directly after the title page. It will include your
paper’s title (which should appear on every page as the running head), and the
word Abstract at the top, centered on its own line. The first line of text on the
abstract should not be indented. Note: Most papers written in APA style
contain an abstract, but your teacher may not require one. Check with your
teacher for the paper’s specific requirements.

• Body – This is the content of your paper.
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• References – This page is a comprehensive list of all the sources you cited
within the paper. It functions like a works cited page. It appears at the end as
its own page. For further detail, see the References section of this document.

The Title Page 

Running Head: ALTERNATIVE FUEL SOURCES FOR AUTOMOBILES 1 

Alternative Fuel Sources for Automobiles 

Kermit T. Frog 

Connections Education 

The running head includes the words 
Running head (in sentence case) and is 
flush left. The page number is flush 
right. 

Include: 

• the running head
• the page number
• the title in all caps
• your name
• your institutional affiliation

The Abstract Page 

ALTERNATIVE FUEL SOURCES FOR AUTOMOBILES   2 

Abstract 

Today more than ever, people are looking to scientists and engineers to find new ways to 

power our cars and trucks. Rising oil prices, due to instability in the Middle East and an aging 

fuel refining infrastructure, and environmental concerns are causing drivers to look at the 

possibility of driving cars powered by sources other than oil. There are several sources to 

consider, ranging from hydrogen to fuels from . . . 

The running head is flush left. The page 
number is flush right. The word Abstract 
is centered on the page and on its own 
line. The first line of text is not 
indented. 
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Citing Sources: What Is the Purpose? 
It is extremely important that you cite, or identify, the sources you used to write your 
paper. If you do not cite your sources, your work could be considered plagiarism.  

Plagiarism occurs when someone uses another person’s words, products, or ideas 
without properly acknowledging the original work. The simplest form of plagiarism is 
copying someone else’s words and claiming as your own. Another form of plagiarism 
is using another person’s ideas and claiming them as your own.  

Plagiarism can be unintentional, too. Even if you simply forget to cite your sources, it 
could still be considered plagiarism. By properly citing your sources, you will avoid 
any cause for concern. 

This document introduces formatting and citing sources. To review APA style in more 
depth, including how to cite source types not covered in this document, visit the 
Purdue Online Writing Lab website. 

Citing Sources in Your Paper 
There are two important steps to follow in order to correctly cite sources for your 
paper. The first step is citing the source within your paper. For this, APA recommends 
using parenthetical citation. 

Citations for Paraphrased Information 
The following is a passage from a book by Michele Anthony about running cars on 
vegetable oil.  

Does the car in front of yours smell like a deep fryer? It’s probably a diesel that has 
been converted to run on vegetable oil. Many people are buying old diesel cars at a 
bargain and then converting them. Not only does making the switch reduce the CO2 
in the atmosphere, it allows drivers to run their vehicles virtually for free—assuming 
they recycle used oil from restaurants. But read closely. It takes a moderate amount 
of patience and know-how to convert your car smoothly and safely. 

The following sentence is an example of a research paper that restates some of the 
information found in the passage from Michele Anthony’s book. When you paraphrase 
information (i.e., don’t quote it directly), identify the source’s author within the text of 
your paper (at the end of the sentence), including the author’s last name and the year 
of publication in parentheses. A comma separates the name and the year. 

Converting a diesel engine reduces CO2 and allows drivers to run their vehicles for free (Anthony, 

2010). It takes . . . 
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Citations for Directly Quoted Information  
When you use direct quotes from the source, include the author’s last name, the year of 
publication, and the page number preceded by “p.” in parentheses. A comma 
separates the name and the year. 

If you get a whiff of French fries while sitting in traffic, it’s probably not fast food—it’s more 

likely “a diesel that has been converted to run on vegetable oil” (Anthony, 2010, p. 14). 

If you use the author’s name in the sentence, include the date of publication by his or 
her name, and the page number at the end of the quote. 

While Anthony (2010) highlights the benefits, she notes that the conversion “requires a moderate 

amount of patience and know-how” (p. 17). 

Additional Styles of Parenthetical Citation 
Citing Works When You Don’t Know the Author – Use the title of the work and 
the publication year. 

Suppose you cite a newspaper editorial, “Why Light Rail Is Good For Everyone,” 
published in 2014. The editorial does not include the author’s name. Include the 
name of the article (it can be shortened if it’s longer) and the publication date. 

The benefits of public transportation—including the proposed light rail system—reach not just to 

those who cannot afford cars, but even to those at the highest income levels in the community 

(“Why Light Rail,” 2014). 

Using More Than One Source from the Same Author – You can also use the title 
of the work when you are citing more than one source from the same author. For 
example, if you are citing both Anthony’s article “Free Ride” and her book Greening 
Your Life, use the name of each source in the parenthetical citation. 

Not only does Anthony endorse alternative fuels by calling them “the wave of the future” (“Free 

Ride” 4), she also offers many additional ways to make an environmental impact in the home, 

such as “recycling, paying attention to the thermostat, and powering off electronics whenever 

possible” (Greening Your Life 58).  
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Citing Two Authors with the Same Last Name – Use the author’s first initial with 
the last name. 

Some scientists believe that we are at a significant crossroads in the development of new fuel 

sources (A. Peterson 98). Some say creating new sources could cause a “disastrous rise” in the 

cost of living (Q. Peterson 24). 

Citing Websites – Since websites don’t use page numbers, use the author’s name, 
the article title, and the date of publication. If there is no author, include the title of 
the website and the year. If there is no date, use “n.d.” (include the quotation 
marks). 

According to experts, by the end of the 21st century, energy trends will shift away from fossil 

fuels toward alternative sources. Coal, currently the most abundant fuel, will likely run out in 250 

years (“Energy, 2013”). 

As with a print source, if you use the exact wording from the source, surround those 
words with quotation marks. 

According to the author, Earth is “slowly running out of gas as it speeds down the road” 

(“Energy”). 

Personal Interview/Communication – Include the name of the person 
interviewed, followed by a comma. Then add the words personal communication, 
followed by a comma. End with the date the interview occurred.  

Mr. Bashir provided his account of his time as an employee of a wind farm. Bashir outlined 
his duties and his opinions on wind power, stating he was “pleased to work with a renewable energy 
source” (J. Bashir, personal communication, February 8, 2013). 

Note: A personal communication is not included on the references page because it is 
a resource that cannot be retrieved. 

Block Quotations – Sometimes you may want to include a long quotation (which is 
often referred to as a block quote). These block quotes—40 words or longer—require 
special formatting. The entire quote should be indented 1 inch from the left margin. 
Since it is set off from the rest of the text in this way, it is clear that it’s a quote and 
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therefore does not need quotation marks. The parenthetical citation is placed after 
the last punctuation in the quote. 

The argument for continuing to develop initiatives for offshore wind power is clear: 

Wind is a clean and renewable energy source that can have a tremendous impact 

on energy use nationwide. The economical effects are clear and immediate: 

adoption of wind power will stabilize prices for consumers and reduce the 

overwhelming but often hidden cost of gas emissions (Weingarten, 2002, p. 22). 

© 2016 Connections Education LLC. All rights reserved. 
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Citing Sources in a References Page 
You’ve learned that citing sources within your paper is very important. It is just as 
important to create page that organizes all of your references. The references page 
provides detailed information about the sources you used in your paper.  

Specific information about publishing, such as the city of publication and the name of 
the publisher, can usually be found on the first few pages of a book or magazine. 

Formatting the References Page 
Use the following guidelines when formatting the references page: 

• Indent all lines after the initial line by one-half inch.
• Cite author’s names as last name followed by first name.
• The reference page should be alphabetized by authors’ names.

Some of the most common types of citations are as follows. 

Book Citations 
The following formatting is the given for books and will deviate only slightly based on 
the number of authors. 

Book by One Author 

List the information as follows: 

• author’s last name and first initial

• year of publication listed in parenthesis

• book title (in italics, listed in sentence case)

• location, including city and state; use the state’s postal abbreviation

• publisher

Anthony, M. (2006). Greening your life. New York, NY: Faraway Press.

Book by More Than One Author 

List the author’s names in the order they appear on the book title. Use the authors’ 
first initials instead of their first names. Use an ampersand symbol to separate the 
names. The rest of the formatting is the same as a book with one author. 

Vinson, J.  & Robertson, M. (2004). Texas and the great depression. Houston, TX: Texas 

Press. 
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Encyclopedia Citations 
List the information as follows:  

• author’s last name and first initial

• the year of publication in parenthesis

• the topic of the entry

• the word In followed by the encyclopedia’s name

• the volume and page numbers in parenthesis

• city and state of publication

• the publisher

Model, A. (1993). Carbon. In Encylopedia Examplica. (Vol. 21, pp. 107–108). Chicago, IL:

Encylopedia Examplica Press. 

Magazine and Newspaper Citations 
Newspaper Article 

List the information as follows: 

• author’s last name and first initial

• year and date of publication (note the order of the date)

• article title (no quotes, listed in sentence case)

• publication name

• page number (designate the page number(s) with p. or pp.)

Acosta, L. (2004, August 16). New fuels come to Springfield. Springfield Telegram, pp.

A4–A5. 

Magazine Article 

List the information the same as you would a newspaper article, except do not 
designate the page number with a p. or pp. Also include the volume number after the 
publication name. 

Anthony, M. (2010, March 5). Free ride. Outside the Lines, 4, 12–16. 
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Web Citations 
Basic Website Citation 

Follow the same formatting as you would for the equivalent print resource. When 
possible, include the year, month, and date. If that information is not available, use 
the year of publication. Include the phrase Retrieved from before listing the URL. 

Article from an Online Periodical 

Cromie, W. J. (2015, August 4). Alternative energy sources. The New Book of Popular 

Science. Grolier Online. Retrieved from http://nbps.grolier.com/ 

cgi-bin/article?assettype=t&assetid=4034970. 

Scholarly Journal Referenced Online 

List the information the same as you would a magazine article. Also include the 
volume number after the publication name. 

Baxter, A. (1998). Confronting nationalism and feminist identity: the voice of women in 

the British Isles. Women's Literature 16.1. 41–50. 

http://womensliterature/confrontingnationalism.org 

Note: APA recommends listing an article’s Digital Object Modifier (DOI) when it’s 
available instead of the journal’s URL; this makes it easier to reference later. Consult 
with your teacher if you have questions about how to use or cite scholarly journals. 

Article from a Database 

List the information the same as you would a magazine article. Also include the 
volume number after the publication name. 

Rockne, N. (2011). Day at the garbage dump. Fuel Hunter, 6, 120–125. Retrieved from 

www.fuelhunter.com. 
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Formatting Your References Page 
The references page follows the last page of your research paper. To ensure it 
begins on its own separate page, insert a page break after the last sentence of your 
paper.  

• To insert a page break: Select the Insert tab, then select Page Break.

The references page has the same margins, double-spacing, and header as your 
paper. The page’s title, References, should be centered on the top line of the page. 
You do not need to put extra line spaces between your sources. However, you will 
need to indent the second (and any additional) lines of your source. 
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